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Introduction

The iIASL compiler is a translator for the ACPI Source Language (ASL). As part of the Intel ACPI
Component Architecture, the Intel ASL compiler implements translation for the ACPI Source
Language (ASL) to the ACPI Machine Language (AML). The disassembler feature will disassemble
compiled AML code back to (near-original) ASL source code.

Major features of the iIASL compiler include:

e  Full support for the ACPI 4.0 Specification including ASL grammar elements and operators.

e Extensive compiler syntax and semantic error checking, especially in the area of control
methods. This reduces the number of errors that are not discovered until the AML code is
actually interpreted (i.e., the compile-time error checking reduces the number of run-time
errors.)

e  Multiple types of output files. Besides binary ACPI tables output options include formatted
listing files with intermixed source, several types of AML files, and error messages.

e Portable code (ANSI C) and source code availability allows the compiler to be easily ported and
run on multiple execution platforms.

e  Support for integration with the Microsoft Visual C++ (or similar) development environment.

o Disassembly of all ACPI tables, including tables that contain AML (DSDT, SSDT) as well as
ACPI “data” tables such as the FADT, MADT, SRAT, etc.

Compiler Overview

Input Files

e Existing ACPI ASL source files are fully supported. Enhanced compiler error checking will
often uncover unknown problems in these files.

o All ACPI 4.0 ASL additions are supported. The compiler fully supports ACPI 4.0.

Output File Options

e AML binary output file
e AML code in C source code form for inclusion into a BIOS project
e AML code in x86 assembly code form for inclusion into a BIOS project

e AML Hex Table output file in either C or x86 assembly code as a table initialization statement.
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2.3

3.1

3.2

3.3

(in tel)
Listing file with source file line number, source statements, and intermixed generated AML

code. Include files named in the original source ASL file are expanded within the listing file

Namespace output file — shows the ACPI namespace that corresponds to the input ASL file
(and all include files.)

Debug parse trace output file — gives a trace of the parser and namespace during the compile.
Used to debug problems in the compiler, or to help add new compiler features.

Environments Supported

Runs on multiple platforms as a 32-bit application. Generation and operation as a 64-bit
operation has not been tested and is not supported at this time.

Portable code — requires only ANSI C and a compiler generation package such as Bison/Flex or
Yacc/Lex.

Error and warning messages are compatible with Microsoft Visual C++, allowing for
integration of the compiler into the development environment to simplify project building and
debug.

Source code is distributed with the compiler binaries

Compiler Analysis Phases

General ASL Syntax Analysis

Enhanced ASL syntax checking. Multiple errors and warnings are reported in one compile — the
compiler recovers to the next ASL statement upon detection of a syntax error.

Constants larger than the target data size are flagged as errors. For example, if the target data
type is a BYTE, the compiler will reject any constants larger than OxFF (255). The same error
checking is performed for WORD and DWORD constants.

General Semantic Analysis

All named references to objects are checked for validity. All names (both Namepaths and 4-
character Namesegs) must refer to valid declared objects.

All Fields created within Operation Regions and Buffers are checked for out-of-bounds offset
and length. The minimum access width specified for the field is used when performing this
check to ensure that the field can be properly accessed.

Control Method Semantic Analysis

Method local variables are checked for initialization before use. All locals (LOCALO -
LOCALY7Y) must be initialized before use. This prevents fatal run-time errors for uninitialized
ASL arguments.
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e Method arguments are checked for validity. For example, a control method defined with 1
argument can’t use ARG4. Again, this prevents fatal run-time errors for uninitialized ASL
arguments.

e Control method execution paths are analyzed to determine if all return statements are of the
same type — to ensure that either all return statements return a value, or all do not. This
includes an analysis to determine if execution can possibly fall through to the default implicit
return (which does not return a value) at the end of the method. A warning is issued if some
method control paths return a value and others do not

Control Method Invocation Analysis

e All control method invocations (method calls) are checked for the correct number of arguments
in all cases, regardless of whether the method is invoked with argument parentheses or not (e.g.
both ABCD() and ABCD). Prevents run-time errors caused by non-existent arguments.

o All control methods and invocations are checked to ensure that if a return value is expected and
used by the method caller, the target method actually returns a value.

Predefined ACPI Names

o For all ACPI reserved control methods (such as _STA, _TMP, etc.), both the number of
arguments and return types (whether the method must return a value or not) are checked. This
prevents missing operand run-time errors that may not be detected until after the product is
shipped.

e Reserved names (all names that begin with an underscore are reserved) that are not currently
defined are flagged with a warning.

Compiler Optimizations

The compiler implements several optimizations whose primary intent is to reduce the size of the
resulting AML output.

Named References

Namepaths within the ASL can often be optimized to shorter strings than specified by the ASL
programmer. For example, a full pathname can be optimized to a single 4-character ACPI name if
the final name in the path is within the local scope or is along the upward search path to the root
from the local scope. In addition, the carat () operator can often be used to optimize namepaths.

Integers

Certain integers can be optimized to single-byte AML opcodes. These are: 0, 1, and -1. The opcodes
used are Zero, One, and Ones.
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4.3 Constant Folding

All expressions that can be evaluated at compile-time rather than run time are executed and reduced
to the simplified value. The ASL operators that are supported in this manner are the Type3, Type4,
and Type5 operators defined in the ACPI specification.

The iASL compiler contains the ACPICA AML interpreter which is used to evaluate these
expressions at compile time.

5 Compiler Operation

The IASL compiler is a command line utility that is invoked to translate one ASL source file to a
corresponding AML binary file or the reverse. The syntax of the various command line options is
identical across all platforms.

51 Command Line Invocation

The general command line syntax is as follows:

iasl [options] Filel, file2, .. fileN

5.2 Wildcard Support

On Windows, wildcard support is implemented within the compiler. For other platforms, it is
expected that the shell or command line interpreter will automatically expand wildcards into the
argv array that is passed to the compiler main().

5.3 Command Line Options

All compiler options are specified using the *-* (minus) prefix. These options are summarized
below, and described in detail after.

Global:
-@<File> Specify command file
-I<dir> Specify additional include directory

General Output:

-p<prefix> Specify path/filename prefix for all output files
-va Disable all errors and warnings (summary only)

-vi Less verbose errors and warnings for use with IDEs
-vo Enable optimization comments

-vr Disable remarks

-vs Disable signon

-w<1]2]3> Set warning reporting level
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AML Output Files:

-s<alc> Create AML in assembler or C source file (*.asm or *.c)
-i<alc> Create assembler or C include file (*.inc or *.h)
-t<alc> Create AML in assembler or C hex table (*.hex)

AML Code Generation:

-oa Disable all optimizations (compatibility mode)
-of Disable constant folding

-oi Disable integer optimization to Zero/One/Ones
-on Disable named reference string optimization

-r<Revision> Override table header Revision (1-255)

Listings:
-1 Create mixed listing file (ASL source and AML) (*.Ist)
-In Create namespace file (*.nsp)
-Is Create combined source file (expanded includes) (*.src)

AML Disassembler:

-d [File] Disassemble or decode binary ACPl table to file (*.dsl)
-dc [File] Disassemble AML and immediately compile it
(Obtain DSDT from current system if no input file)
-e [f1,f2] Include ACPI table(s) for external symbol resolution
-2 Emit ACPI 2.0 compatible ASL code
-g Get ACPI tables and write to files (*.dat)
Help
-h Additional help and compiler debug options
-hc Display operators allowed in constant expressions
-hr Display ACPl reserved method names

Global Options

These options affect the compiler globally.

-@<file> Read additional command line options from a command file. The format of this text file
is one complete option per line.

-I<dir>  Specify an additional directory for include files. The directory that contains the source
ASL file is searched first. Then, any additional directories specified via this option are

searched. This option may be invoked an unlimited number of times. Directories are
searched in the order they appear on the command line.

General Output

These options affect the output of errors and warnings.

-p<prefix> Specify the filename prefix used for all output files, including the .AML file. (This option
overrides the output filename specified in the DefinitionBlock of the ASL.)

-va Disable all errors/warnings/remarks. The compiler signon and compilation summary
information are the only messages.
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5.3.3

5.3.3.1

5.3.3.2

5.3.3.3

534

-Vi Provide less verbose errors and warnings in the format required by the MS VC++
environment. This allows the automatic mapping of errors and warnings to the line of
ASL source code that caused the message.

-vr Disable all remark messages.

-VS Disable the compiler signon.

-w<1|2|3> Set the warning reporting level.

AML Text Output Files

The compiler always emits a binary AML table. These options allow the compiler to create various
text versions of the AML code to simplify the inclusion of the code into a BIOS project.

Source Code Files (-s)

These options create files that contain the AML in hex format, with a unique label for each line of
the original ASL code. This allows the BIOS to easily dynamically access/modify the ACPI table.

-sa Create AML in an x86 assembly source code file with the extension .ASM. This option
creates a file with a unique label on the AML code for each line of ASL code.

-SC Create AML in a C source code file with the extension .C. This option creates a file with
a unique label on the AML code for each line of ASL code.

Source External Declaration Files (-i)

These options create files that contain external declarations for the symbols created by the options in
the previous section.

-ia Create an ASM include file (.INC) that contains external declarations for the symbols
produced by the —sa option above.

-ic Create a C header file (.H) that contains external declarations for the symbols produced
by the —sc option above.

Hex Source Code Files (-t)
These options create files that contain the AML code in hex format, in a single array.

-ta Create a hex table file with the extension .HEX. This file contains raw AML byte data in
hex table format suitable for inclusion into an ASM file.

-tc Create a hex table file with the extension .HEX. This file contains raw AML byte data in
hex table format suitable for inclusion into a C file.

AML Code Generation

These options affect the actual AML code that is generated by the compiler.
-0a Disable all optimizations.

-of Disable the constant folding feature.

10



5.3.5

5.3.6

5.3.7

-0i
-on

-r<Rev>

IASL Compiler User Reference

Disable integer optimizations to the Zero/One/Ones AML opcodes.
Disable named reference string optimizations.

Set the revision number of the table header, overriding the existing revision.

Listings

These options control the listings that are produced by the compiler

Create a listing file with the extension .LST. This file contains intermixed ASL source
code and AML byte code so that the AML corresponding to each ASL statement can be
examined.

Create a namespace file with a dump of the ACPI namespace and the extension .NSP

Create a combined source file with the extension .SRC. This file combines all include
files into a single, large source file.

AML Disassembler

These options are used to invoke and control the behavior of the AML disassembler.

-d [file]

-dc [file]
e [fL,f2]
2

Disassemble or decode a binary ACPI to a file (.DSL). Tables that contain AML code are
disassembled back to ASL code. Tables that do not contain AML code are decoded and
displayed with a description of each field within the table.

Disassemble a binary AML file and immediately compile it.

Include these extra binary AML tables to assist with external symbol resolution.

Emit ACPI 2.0 compatible ASL code.

Get ACPI tables from the local machine (availability depends on the host
implementation.)

Additional help

Display a complete list of all ASL operators that are allowed in constant expressions that
can be evaluated at compile time. (This is a list of the Type 3, 4, and 5 operators.)

Display a list of the ACPI predefined names (reserved names.)

11
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5.4

5.4.1

5.4.2

5.4.3

Examples

Input ASL

Example input ASL:

DefinitionBlock (", "DSDT", 2, "Intel', "EXAMPLE", 1)

{
Name (BSTP, Package() {0,1,2,3})

Method (_BST)

{
Store (BSTP, Debug)

Return (BSTP)

Output of —tc (make C source table) Option

This is the output of the —tc option. The entire table is emitted in a single C array.

N
*

Intel ACP1 Component Architecture

ASL Optimizing Compiler version 20090730 [Aug 12 2009]
Copyright (C) 2000 - 2009 Intel Corporation

Supports ACPl Specification Revision 4.0

Compilation of "dsdt.asl"™ - Fri Aug 14 14:47:07 2009

C source code output

ok % ok k% ok % %

*/unsigned char AmlCode[] =

{
0x44,0x53,0x44 ,0x54 ,0x45,0x00,0x00,0x00, /* 00000000 “DSDTE. ..
0x02,0xF1,0x49,0x6E,0x74,0x65,0x6C,0x00, /* 00000008 “o.Intel.”
0x45,0x58,0x41,0x4D,0x50,0x4C,0x45,0x00, /* 00000010 "EXAMPLE.""
0x01,0x00,0x00,0x00,0x49,0x4E,0x54,0x4C, /* 00000018 Yo INTL™
0x30,0x07,0x09,0x20,0x08,0x42,0x53,0x54, /* 00000020 "0.. .BST"
0x50,0x12,0x08,0x04,0x00,0x01,0x0A,0x02, /* 00000028 P "
0x0A,0x03,0x14,0x12,0x5F,0x42,0x53,0x54, /* 00000030 Y. . _BST"
0x00,0x70,0x42,0x53,0x54,0x50,0x5B,0x31, /* 00000038 " _pBSTP[1"
0xA4,0x42,0x53,0x54,0x50,

¥

Output of —sc (make C source) Option

ey

*/
*/
*/
*/
*/
*/
*/

This is the output of the —sc option. The table is emitted in multiple C arrays, approximatly one

array per “block” of ASL code. For example, one array is emitted per control method.

12
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Intel ACP1 Component Architecture

ASL Optimizing Compiler version 20090730 [Aug 14 2009]
Copyright (C) 2000 - 2009 Intel Corporation

Supports ACPl Specification Revision 4.0

Compilation of "dsdt.asl™ - Fri Aug 14 14:59:46 2009

“DSDTE..." */
"o Intel." */
“EXAMPLE." */
"t LLINTLY %</
"0t xS
BSTP" */
........ */
*/
" _BST." */
"pBSTP[1" */
" _BSTP" */

/*
* 1....
* 2....DefinitionBlock (', "DSDT", 2, "Intel™, "EXAMPLE", 1)
*/
unsigned char DSDT_EXAMPLE_Header [] =
{
0x44,0x53,0x44,0x54 ,0x45,0x00,0x00,0x00, /* 00000000
0x02,0xF1,0x49,0x6E,0x74,0x65,0x6C,0x00, /* 00000008
0x45,0x58,0x41,0x4D,0x50,0x4C,0x45,0x00, /* 00000010
0x01,0x00,0x00,0x00,0x49,0x4E,0x54,0x4C, /* 00000018
0x30,0x07,0x09,0x20, /* 0000001C
}:
/*
* 3____{
4. ... Name (BSTP, Package() {0,1,2,3})
*/
unsigned char DSDT_EXAMPLE_BSTP [] =
{
0x08,0x42,0x53,0x54,0x50, /* 00000021
0x12,0x08,0x04,0x00,0x01,0x0A,0x02,0x0A, /* 00000029
0x03, /* 0000002A
}:
/*
5..
6. Method (_BST)
*/
unsigned char DSDT_EXAMPLE__BST [] =
{
0x14,0x12,0x5F,0x42,0x53,0x54,0x00, /* 00000031
/*
7.. {
8.. Store (BSTP, Debug)
*/
0x70,0x42,0x53,0x54,0x50,0x5B,0x31, /* 00000038
/*
* 9.. Return (BSTP)
*/
OxA4,0x42,0x53,0x54,0x50, /* 0000003D
/*

13
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* 10.... T
* 11....}

* 12....

*/

¥

544 Output of —ic (make include file) Option

This is the output of the —ic option. It creates external declarations for all of the arrays created by the
—sc option above.

N
*

Intel ACP1 Component Architecture

ASL Optimizing Compiler version 20090730 [Aug 14 2009]
Copyright (C) 2000 - 2009 Intel Corporation

Supports ACPI Specification Revision 4.0

Compilation of "dsdt.asl"™ - Fri Aug 14 15:05:34 2009

ok X % ok X % F

*

/

extern unsigned char DSDT_EXAMPLE_Header [];
extern unsigned char DSDT_EXAMPLE_BSTP [];
extern unsigned char DSDT_EXAMPLE__BST [1;

5.4.5 Output of —I (Listing) Option

This is a standard listing file with intermixed ASL and AML code.

Intel ACP1 Component Architecture

ASL Optimizing Compiler version 20090730 [Aug 14 2009]
Copyright (C) 2000 - 2009 Intel Corporation

Supports ACPI Specification Revision 4.0

Compilation of "dsdt.asl"™ - Fri Aug 14 15:08:30 2009

1....
2....DefinitionBlock (', "DSDT", 2, "Intel™, "EXAMPLE", 1)
00000000....44 53 44 54 45 00 00 00 "DSDTE..."
00000008....02 F1 49 6E 74 65 6C 00 "o _Intel."
00000010....45 58 41 4D 50 4C 45 00 "EXAMPLE.™
00000018....01 00 00 00 49 4E 54 4C Yo INTL™
00000020....30 07 09 20 -ccuccccnnn- "0.. "
3....4
4. .. Name (BSTP, Package() {0,1,2,33})

14
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dsdt.asl 4: Name (BSTP, Package() {0,1,2,3})
Optimize 6033 - ~ Integer optimized to single-byte AML

opcode (Zero)

dsdt.asl 4: Name (BSTP, Package() {0,1,2,33})
Optimize 6033 - ~ Integer optimized to single-byte AML

opcode (One)

00000024....08 42 53 54 50 ......... "' _BSTP"
00000029....12 08 04 00 01 OA 02 OA e "
00000031....03 ... ... "

5....
6.... Method (_BST)
00000032....14 12 5F 42 53 54 00 ... "o ._BST."
[ {
8.... Store (BSTP, Debug)
00000039....70 42 53 54 50 5B 31 ... "pBSTP[1"
9.... Return (BSTP)
00000040....A4 42 53 54 50 ......... " _BSTP"
10.... }
11....}
12....

Summary of errors and warnings

ASL Optimizing Compiler version 20090730 [Aug 14 2009]

ASL Input: dsdt.asl - 13 lines, 178 bytes, 4 keywords

AML Output: dsdt.aml - 69 bytes, 2 named objects, 2 executable opcodes

Compilation complete. O Errors, O Warnings, O Remarks, 2 Optimizations

Output of —In (Namespace Listing) Option

This is a namespace listing file.

Intel ACP1 Component Architecture

ASL Optimizing Compiler version 20090730 [Aug 14 2009]
Copyright (C) 2000 - 2009 Intel Corporation

Supports ACPl Specification Revision 4.0

Compilation of "dsdt.asl"™ - Fri Aug 14 15:08:30 2009

Contents of ACPl Namespace

15
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Q
o
c
=]
=

Depth

[11
[11
[11
[11
[11
[11
[11
[11
[11
[11
[11

©O© 0O ~NOO U WNPE

[
o

11

Name

_GPE
_PR_
_SB_
_Si_
_TZ_
_REV
_0S_
_GL_
_osl
BSTP
_BST

Namespace pathnames

\_GPE
\_PR_
\_SB_
\_SI_
\_TZ_
\_REV
\_0S_
\ GL_
\_0sl
\BSTP
\_BST

5.5

This section contains instructions for integrating the iASL compiler into MS VC++ 6.0 development

environment.

5.5.1

Type

Scope
Scope
Device
Scope
Thermal
Integer
String
Mutex
Method
Package
Method

[Initial Length
[Code Length

Integration as a Custom Tool

0x04 elements]
0x0011 bytes]

Integration Into MS VC++ Environment

This procedure adds the iASL compiler as a custom tool that can be used to compile ASL source
files. The output is sent to the VVC output window.

a) Select Tools->Customize.

b) Select the "Tools" tab.

c) Scroll down to the bottom of the "Menu Contents" window. There you will see an empty
rectangle. Click in the rectangle to enter a name for this tool.

d) Type "IASL Compiler" in the box and hit enter. You can now edit the other fields for this new

custom tool.

e) Enter the following into the fields:

Command:

Arguments:

C:\Acpiliasl.exe

-e "$(FilePath)"

16
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Initial Directory: "$(FileDir)"

Use Output Window: <Check this option>

"Command" must be the path to wherever you copied the compiler.

"-e" instructs the compiler to produce messages appropriate for VVC.

Quotes around FilePath and FileDir enable spaces in filenames.
f) Select "Close".
These steps will add the compiler to the tools menu as a custom tool. By enabling "Use Output
Window", you can click on error messages in the output window and the source file and source line

will be automatically displayed by VC. Also, you can use F4 to step through the messages and the
corresponding source line(s).

5.5.2 Integration into a Project Build

The compiler can be integrated into a project build by using it in the “custom build” step of the
project generation. The commands and arguments should be similar to those described above.

6 Disassembler

6.1 AML ACPI Tables (DSDT, SSDT, etc.)

Because the AML contains all of the orginal symbols from the ASL, the AML byte code can be
disassembled back to nearly the original ASL code.

6.2 ACPI Data Tables (FADT, MADT, SRAT, etc.)

These non-AML ACPI tables can be “disassembled”, meaning that they are formatted with the
individual fields and data.

Example disassembly of an FADT.

Intel ACPI Component Architecture
AML Disassembler version 20090730

*
*
*
* Disassembly of FACP.dat, Wed Aug 12 14:18:28 2009
* ACPI Data Table [FACP]

*

*

Format: [HexOffset DecimalOffset BytelLength] FieldName : FieldValue
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[000h
[004h
[008h
[009h
[00Ah
[010h
[018h
[0ich
[020h

[024h
[028h
[02ch
[02Dh
[02Eh
[030h
[034h
[035h
[036h
[037h
[038h
[03ch
[040h
[044h
[048h
[04ch
[050h
[054h
[058h
[059h
[05Ah
[05Bh
[05Ch
[05Dh
[05Eh
[05Fh
[060h
[062h
[064h
[066h
[068h
[069h
[06Ah
[06Bh
[06Ch
[06Dh

[06Fh

0000
0004
0008
0009
0010
0016
0024
0028
0032

0036
0040
0044
0045
0046
0048
0052
0053
0054
0055
0056
0060
0064
0068
0072
0076
0080
0084
0088
0089
0090
0091
0092
0093
0094
0095
0096
0098
0100
0102
0104
0105
0106
0107
0108
0109

0111

4]
4]
1]
1]
6]
8]
4]
4]
4]

4]
4]
1]
1]
2]
4]
1]
1]
1]
1]
4]
4]
4]
4]
4]
4]
4]
4]
1]
1]
1]
1]
1]
1]
1]
1]
2]
2]
2]
2]
1]
1]
1]
1]
1]
2]

1]

Signature :

Table Length :

Revision :

Checksum :

Oem ID :

Oem Table ID :

Oem Revision :

Asl Compiler ID :

Asl Compiler Revision :

FACS Address :
DSDT Address :
- 00
PM Profile :

SCI Interrupt :

SMI Command Port :
ACP1 Enable Value :
ACPIl Disable Value :
S4B10S Command :

- 00

Model

P-State Control

PM1A Event Block Address :
PM1B Event Block Address :
PM1A Control Block Address :
PM1B Control Block Address :
PM2 Control Block Address :
PM Timer Block Address :
GPEO Block Address :

GPE1 Block Address :

PM1 Event Block Length :

PM1 Control Block Length :
PM2 Control Block Length :
PM Timer Block Length :

GPEO Block Length :

GPE1 Block Length :

GPE1 Base Offset :

_CST Support :

C2 Latency :

C3 Latency :

CPU Cache Size :

Cache Flush Stride :

Duty Cycle Offset :

Duty Cycle Width :

RTC Day Alarm Index :

RTC Month Alarm Index :

RTC Century Index :

: 0003
Legacy Devices Supported (V2) :
8042 Present on ports 60/64 (V2) :
VGA Not Present (V4) :
MSI Not Supported (V4) :
PCle ASPM Not Supported (V4) :
Reserved :

Boot Flags (decoded below)

""FACP
00000084
02

E3

"INTEL **
''0944 "
00000002
"INTL™
00000001

37FF7E80
37FES58DC

00 (Unspecified)
0009

000000B0

F1

FO

F2

00008000
00008104
00008004
00000000
00008100
00008008
00008020
00000000
04

02

01

04

08

00

00

00

03E7
03E9
0000
0000

01

03

oD

00

32

O O ORrPF

18
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7.1

[070h 0112 4]
WBINVD instruction is operational
WBINVD flushes all caches

All CPUs support C1

C2 works on MP system

Control Method Power Button
Control Method Sleep Button

RTC wake not in fixed reg space
RTC can wake system from S4
32-bit PM Timer

Docking Supported

Reset Register Supported

Sealed Case

Headless - No Video

Use native instr after SLP_TYPx
PCIEXP_WAK Bits Supported

Use Platform Timer

RTC_STS valid on S4 wake

Remote Power-on capable

Use APIC Cluster Model

Use APIC Physical Destination Mode

[074h 0116 12]

[074h 0116 1] Space ID :
[075h 0117 1] Bit Width :
[076h 0118 1] Bit Offset :
[077h 0119 1] Access Width :
[078h 0120 8] Address :

[080h 0128 1]
[081h 0129 3]

Flags (decoded below)
V1) :
(V1) :
V1) :
V1) :
V1) :
V1) :
V1) :
(V1) :
V1) :
V1) :
w2) :
w3) :
3) :
3) :
w4 :
w4 :
w4 :
w4 :
wa) :
wa) :

Reset Register :

Value to cause reset :
Reserved :

IASL Compiler User Reference

- 000001A5

OO0 00000000 O0OFrRrPOPFPOORFR O

<Generic Address Structure>
01 (SystemlO)

08

00

00

0000000000000000

00
000000

Compiler Generation From Source

Generation of the ASL compiler from source code requires these items:

Required Tools

1) The flex (or Lex) lexical analyzer generator

2) The Bison (Yacc replacement) parser generator

3) An ANSI C compiler

19
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7.2 Required Source Code

There are three major source code components that are required to generate the compiler

1. The ASL compiler source

2. The ACPICA Core Subsystem source. In particular, the Namespace Manager component is
used to create an internal ACPIl namespace and symbol table.), and the AML Interpreter is
used to evaluate constant expressions.

3. The Common source for all ACPI components

The source files appear in these directories by default:

Compiler Source: Acpica/Source/Compiler
Common Source: Acpica/Source//Common
Subsystem Source: Acpica/Source/Components/

20
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